Ammonium Inhibition Experimental Procedure

Last revised 2-12-13 By Claire Griebenow

Index

Introduction

I. Purpose
II. Experimental Overview

Preparation

III. Prepping Vials Part 1
   a. Washing
   b. Labeling
   c. Making Standard Vials
   d. Filling Soil Vials

IV. NH₄Cl
   a. Important Precautions
   b. Supplies
   c. Dilution of NH₄Cl

V. Mylar Gas Bags
   a. Overview
   b. Bag Dilution

VI. Prepping Vials Part 2
   a. Adding NH₄Cl to Soil Vials
   b. Methane Injection
   c. Incubation

VII. Time (0), non-incubated vials

Gas Sampling

Glossary

Appendicies A-C
Ammonium Inhibition Experimental Procedure

Introduction

I. Purpose
1. This manual will describe how to perform an experiment in the Joe von Fischer Laboratory dealing with ammonium inhibition enzyme kinetics. We will examine methane oxidation by methanotrophs in soil from sites located in the Great Plains of the United States.
2. Because ammonium and methane have similar molecular structures, it is thought that the enzyme in methanotrophs responsible for methane oxidation, methane momoxygenase, is inhibited by the presence of ammonium.
3. In the lab, we will be working with soil that has been shipped to us in iced coolers from our field sites in the Great Plains. We will use soil that has been sieved through 2mm sieves and stored in the refrigerator in Ziploc bags to slow microbial activity and maintain moisture balance.

II. Experiment Overview
1. In this experiment, we examine the effect of various concentrations of NH$_4^+$ on the rate of CH$_4$ oxidation in soils from the Great Plains. In 60 mL vials, we incubate soil slurries at six different dilutions of NH$_4$ (0.1mM, 0.3mM, 1mM, 3mM, 10mM, and 100mM).
2. The headspace of the vials contains a methane concentration of 20ppm. The vials are incubated for a period of 48 hours, during which four gas samples are taken using a Gas Chromatograph autosampler and a Los Gatos Research Methane/Carbon Dioxide Analyzer in order to characterize the relationship between NH$_4$ level and CH$_4$ oxidation.
3. We incubate and sample two different plots, which have been divided into six cores, each containing the ammonium and methane. In these runs, a set of control and standard vials with no soil will also be gas sampled.
   a. The control vials contain methane and will be incubated with the soil samples. They are used to test for variations and gas leakage during incubation. Theoretically, the concentration of methane in these vials should not change.
   b. Standard vials are not incubated and contain only known methane concentrations, as they are used as calibrants to calculate the amount of methane in the sample and control vials. There are three sets of two standards for each plot. The three sets of methane concentrations are designed to encompass concentrations that may be seen in each vial throughout the incubation.
c. The standard bottles are labeled “Std 2/3/4 - #” with the first number representing the known standard methane concentration and the second number representing the bottle number. Standard 2 has a concentration of 5.03 ppm CH₄, standard 3 has a concentration of 15 ppm CH₄, and standard 4 has a concentration of 30 ppm. (Refer to Appendix A)
d. Air vials are blanks that begin each run before the standard vials; they contain no important data.

Preparation

III. Prepping Vials Part 1
1. Washing
   a. Wash the bottles in a clean tub with Liquinox non-nitrogen soap.
      - Shake each bottle to ensure the soap foams.
      - Rinse each bottle five times with DI water, making sure no soap remains.
      - Set up a drying rack using a clean metal rack with separators so the bottles dry upside-down.
      - Allow the bottles to dry overnight.
   
2. Labeling
   a. Using either the P-touch PC-Connectable Label Maker or handwritten tough tags, label bottles according to Appendix A. Place labels on the upper 2/3 of the bottle so the bottles can fit into the auto sampler tray with label showing.
   b. Also label the last 12 vials for DI water (See appendix A). These will be incubated with DI water, soil and methane to act as a zero level of ammonium.
   c. Obtain two extra vials (they do not have to be washed) and label them Air 1 and Air 2.

3. Making Standard Vials
   a. The standard bottles should be capped with butyl stoppers and sealed with the aluminum crimper. The bottles should then be evacuated just past 200 militor/microns by the evacuator, making sure to be as consistent as possible.
   b. Inject 90 mLs of each standard into the appropriate bottle according to Appendix A. Make sure that the syringes are washed by filling them three times with gas prior to injection, and keep separate syringes for each standard.

*It is critical to be as accurate and precise as possible when making the standards, because they are used for calculations of methane concentrations.

4. Filling Soil Vials
   a. Use two different plots that have already been sieved and sampled; they should have six cores with at least 90 g per core. Print a soil weight sheet from the A.I. template and be sure that
you have all the bottles in order before you begin weighing. Record the sampling dates as well as the plot names on the soil weight sheet. The first number after A/B signifies the core used from each plot. From each core seven bottles will be filled.

b. Use a weigh boat and medium funnel with a neck of about 2.5cm. Use ethanol to clean your spoon, boat and funnel between each core. Place the weigh boat on the scale, and zero it; after mixing around the soil in the bag, weigh 10g of soil, getting as close to 10.00 as possible (within 9.98-10.02 is acceptable). Be sure to record the soil’s exact mass on the data sheet.

c. Transfer the soil to the appropriate bottle using the funnel and then cap with a butyl stopper only. The soils should be placed uncapped in the refrigerator until they are ready to be filled with water/ammonium.

IV. NH₄Cl

1. IMPORTANT PRECAUTIONS: NH₄Cl is volatile and can easily contaminate the lab. Always properly seal containers, wear gloves and clean your workspace.

2. Supplies
   a. For one run, use six clean 2L plastic bottles; label the bottles 0.1mM, 0.3mM, 1mM, 3mM, 10mM, and 100mM NH₄Cl. The bottles should be washed in the same way as the soil vials (See Section III, Part 1: Washing).

3. Dilution of NH₄Cl
   a. In the 100mM and 3mM bottles, add 2L of DI water. In the remaining bottles, add 1.8L of DI water. The NH₄Cl can be found in the chemical cabinet.

   *To avoid NH₄ contamination/volatilization, use gloves and seal NH₄Cl bottle in a Ziploc bag when not in use. Do not handle the NH₄Cl when any experiments with KCl testing for inorganic nitrogen are being done.

   b. Weigh in a small beaker on the scale 10.70g of NH₄Cl and carefully pour into the 100mM plastic bottle. Mix the contents well by capping and shaking the plastic bottle.

   c. Weigh in a small beaker on the scale 0.321g of NH₄Cl and carefully pour into the 3mM plastic bottle. Mix the contents well by capping and shaking the plastic bottle.

   d. Use a pipette labeled 100mM NH₄⁺ to transfer 200mL of the 100mM NH₄⁺ bottle to the 10mM bottle. Mix this bottle well and transfer 200mL from the 10mM bottle to the 1mM bottle using a separately 10mM-labeled pipette; mix. Transfer another 200mL from the 1mM bottle using another labeled pipette (labeled 1mM) to the 0.1mM bottle. Make sure all bottles are well mixed.
e. Use a pipette labeled 3mM NH$_4^+$ to transfer 200mL of the 3mM NH$_4^+$ to the 0.3mM bottle. Mix this bottle well.

f. Save all labeled pipette tips in separate, sealed Ziploc bags for addition of NH$_4$Cl to soil vials.

V. **Mylar Gas Bags**

1. **Overview**
   a. The gas bag is used to quickly inject the appropriate dilution of methane into each vial so the concentration of methane in the headspace is 20ppm. This is done just prior to incubation. Refer to Appendix B for the appropriate dilution used for the bag.
   b. We will be using a Mylar bag because they are able to prevent gas from leaking when sealed, for up to three weeks. Mylar can easily puncture, so avoid placing it around heavy or pointy objects. Label the bag with the date and methane concentration before beginning.

2. **Bag Dilution**
   a. Rinse the bag out three times using the specified tank in Appendix B. To rinse:
      - Secure the bag to the tank of the appropriate concentration, and fill the bag slightly.
      - Remove the bag from the gas tank and secure into the evacuator. Turn on the evacuator, open the valve, and evacuate the bag completely. Be sure you do not puncture the Mylar from over-evacuation. Close the valve.
      - Repeat two more times.
   b. For the vial dilution bags, use the large 100mL Hamilton syringe. Be sure to rinse the syringe three times before using a new tank or room air, in order to avoid contamination. (See Appendix B for dilutions) Seal the bags by closing the valve, once the appropriate dilution has been achieved.
   c. Place a 3-way valve with an attached syringe on the bag. This allows for quick and efficient injection of gas into the vials.

VI. **Prepping Vials Part 2**

1. **Adding NH$_4$Cl to Vials**
   a. Using the plastic pipette tips saved in Ziploc bags, draw 10mL of the appropriate dilution of ammonium and add to the soil vials according to Appendix A. Be sure not to cross contaminate dilutions.
   b. Cap vials with the grey butyl stopper and crimp using aluminum lid.
   c. Discard the pipette tips in their sealed Ziploc bags.

2. **Methane Injection**
   a. Using the 3-way valve system and a needle, inject 25mL of the diluted methane from the Mylar bag into the vials. Appendix A details which vials should have which concentration of
methane. Make sure plunger remains depressed until the needle/syringe is pulled out of the vial.

b. Inject 30 ml of methane from bag into control vials. These vials should not contain soil or water (see appendix A).

3. Incubation
   a. Place the vials in the trays to be incubated. Refer to Appendix C for proper vial order in trays. Do not shake standards, set them aside in GC room for later sampling.
   b. Record start time of shaking on the soil weight sheet.
   c. Secure the trays on the shake table; use empty trays as placeholders on the incubator. Power the machine on and set the level of rmps to 200. Be sure that the trays are not sliding. Allow these to shake overnight, until you are ready to take your first round of gas samples the next day.
   d. In between gas sampling, make sure the vials are continuously secure and shaking on the shake table.

Gas Sampling
   I. Preparation
      a. Turn the shaker off and take out only the trays that will be used for sampling the current run. Turn the shaker on while you are gas sampling so that the other vials can continue to incubate.
      b. Place the vials in the correct order for the Gas Chromatograph run according to Appendix C. Secure the vials using the rubber band and dowel system.

   II. Methods and Sequences Overview
      a. The method used for a run determines properties of how the Auto Sampler is ran (i.e. sample volume and location of vials/injection port).
      b. A sequence file can be opened in EZStart, the program that allows information to be stored. A sequence file is a template that contains the sequence of the vials for the GC run, it can be saved and will store vial names, calibration levels, and a specific method file that it uses to acquire data for the LGR. There are template sequence files that have been created for each specific sequence. The template files are saved
as Template A or Template B in O:\EZStart\Projects\Great Plains Methane\AI.

III. Naming Folders and Sequences Overview
a. Ammonium Inhibition Data is sorted in folders by the sampling year (2011/2012), in a folder by the site and then by a folder by the date and time at which the sample is taken. Each sample run will have its own sequence file and folder saved under the folder AI/2012/SITE. The sequence file and folder will hold the same name using the YYMMDD TIME format. The time should be rounded to the nearest estimated half hour (e.g. 110802 130p : August 2, 2011 at 1:30pm). See Preparing the GC Room for a Run for creating folders and Sequences.

IV. Preparing the GC Room for a Run
Below are step-by-step instructions for preparing a run.
a. If not already on, flip the zero gas tank switch (black lever) up so that gas is flowing. You may have to turn the silver knob on top as well if this has been shut off. Check the pressure gauge to ensure the tank will not run out during a run. Tank pressure should be around 50-100kPa unless it is running low, in which the pressure will be lower. Keep an eye on how fast the tank is running out and replace with new tank at the appropriate time or inform Sam/Paul/Joe that the tank is low.

![Figure 15: Zero air gas tank (N2) with valve flipped on and](image)

b. Check the flow meter (ball should sit between 10 and 15). If it is no be careful when adjusting it.
c. Turn on LGR using the switch on the back-right. While the LGR boots, other prep work can be done but there are still changes to be made using the LGR. See VII – LGR prep for additional changes.
V. Computer Prep
   a. Create a folder for the data files and summary report to be stored in. Open 'My Computer' or the manila folder quick-launch button on the task bar.
   b. Go to: O:\EZStart\Projects\Great Plains Methane\AI\2012. Create a folder inside the 2012 folder naming it with the names of the plot used (ex: SHL) and create a folder in plot folder one using the format YYMMDD TIME for each day of the incubation we sample.
   c. To open a sequence template open EZStart and go to File>Sequence>Open> O:\EZStart\Projects\Great Plains Methane\AI\AI Template A-B. Save as (a new name of YYMMDD TIME) the sequence file for the run (File>Sequence>Save as). Template should be saved under: O:\EZStart\Projects\Great Plains Methane\AI\2012\SITE\SITE\YYMMDD TIME. [Save as the same YYMMDD TIME as the folder you previously created in the folder you created.] (If a run is taking place, open EZStart Offline.)
   d. Make sure the dropdown box in the top left of the toolbar is at "5. CH4 – LG" (not 3. FID)
   e. Now you have to tell the data where to save, define the data and summary path to correct folder by selecting (Sequence>Properties). Make sure the Export Summary Box is checked. Click the green folder button to the right of the “Path” text box and find the folder you’ve just created (YYMMDD TIME). Click the green folder button to the right of the “Data” text box and find the folder you created (YYMMDD TIME), the Data and Path boxes should have the same location: O:\EZStart\Projects\Great Plains Methane\AI\2012\SITE\SITE\YYMMDD TIME.
   f. Select ‘Ok’ and save the sequence (File > Sequence > Save). It will tell you that the current method has changed with a popup box, select save for this as well.
   g. Run Sequence (click green arrow button on the top toolbar) once you are ready to begin sampling. (After you have completed through step XXII. LGR Prep)

VI. Auto Sampler Prep (GC)
   a. Delete Old Jobs: Press F3 ('Del Job') on the Auto Sampler. Choose Selected (if only one job is currently listed) or All (if there are multiple jobs listed) by turning knob and pressing the center button to select your choice.
b. Add Job: Press F2 ('Add Job') > Append. This screen will now let you select the tray, the number of vials to be sampled in that specific tray, and the method.

<table>
<thead>
<tr>
<th>TRAY</th>
<th>mmtray1 or mmtray2</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>1</td>
</tr>
<tr>
<td>Last</td>
<td>n . . . . . . . . . (Actual # of vials in tray)</td>
</tr>
<tr>
<td>Increment</td>
<td>1</td>
</tr>
<tr>
<td>Count</td>
<td>1</td>
</tr>
<tr>
<td>METHOD</td>
<td>HS+5mlv3</td>
</tr>
</tbody>
</table>

c. After you have selected the criterion that you want press F4 ('Home') to return to the main screen. Additional trays can be added in the same manner. Note that the trays will run in same order in which they appear on the main screen. It is not necessary to add all the trays that will sample in a run, especially if it is the same tray that will sample back-to-back. Time will be needed to prepare trays with dowels and to switch out the trays. On the other hand, it is also possible to add a tray to the run after the run has already started. To do this, press F2 ('Add Job') and follow the same procedure as above.

d. Check/change sample volume: Menu (F1) > Method > HS+5mlv3 > Scroll to 'Sample Volume' and Select > Turn knob to desired sample volume > Deselect 'Sample Volume' > Return to Home (F4). Volume the only volume will be 3ml for every sample.

e. OPTIONAL: Check Tray Position: Menu (F1) > Setup > Objects > Trays > Select desired tray > Check Pos (F1)
To continue checking additional positions, press F1.
To exit, press F4 (Home).

VII. LG GHGA Prep
a. Change the number of [CH4] ppm = 5 volts: (Setup > Select ‘OK’ > Select ‘Analog Output’ at the bottom of the
screen > Type number of [CH4] ppm=5volts > Select ‘OK’ > Return (bottom right corner))

[CH4] = 25 ppm – 5 volts
b. Select Wait for a steady baseline level of CH4.

VIII. Recording Information During the Run
a. Use the AI notebook to record: sample name (YYMMDD TIME), and the exact time you begin each site.
b. Record the height of each standard peak/if the red integration line seems appropriate. If anything out of the ordinary occurs be sure to record it in the lab book. This data is very important, and because if anything seems strange in data analysis we can look back at what happened.

IX. Standard Consistency of Calibrants
a. Because the Standard vials are used to calibrate the GC, if the calibrants are off, the data will be bad. To best ensure that the calibration standards are consistent, watch them as they sample. A good way to tell if two vials of the same concentration are similar is to note the peak of the CH4 graph in EZStart. If two standards are way off stop the run, evacuate the vials, and re-inject with the standard air (See Stopping a Run).
b. Also, Check to see that the red integration line lies within the graph. And the peak of the graph is not cut off. If either of these happen, record them in the mm notebook.
c. After all the calibration standards have sampled, check the $R^2$ value to check a goodness of fit. (In EZ Start: Methods > Review Calibration) $R^2$ should be at least 0.99.

X. Between Runs
The template can remain open and in the “Acquiring” mode. After a run on the Auto Sampler has been completed for a run following needs to be done:
a. Change trays according to Appendix C and set up the computer for template B to run the second plot. (See Computer Prep for more information)
b. Update job list if needed. Note that it is important to have the correct number of sampling vials in noted for each individual job. Determining if the job has the correct number of vials is simple. The Auto Sampler Job Queue will read, for example:

```bash
## mmtrey1 001 018
```
c. The last value listed should be the total number of vials in that given tray. If the value is incorrect, select the job and change the number next to ‘Last’.
d. See Preparing the GC Room for a Run for more information.

XI. **Stopping and Restarting a Run**
a. If a run needs to be stopped, wait for the Auto Sampler to finish its current sample. Once the Auto Sampler has returned to its home position, press the ‘Stop’ button on the GC. In the pop-up window, scroll and select ‘Job Queue’.
b. In EZStart, click the red stop button in the top toolbar.
c. If the run is going to be restarted, the data files (one for each vial sampled) from the previous run will need to be deleted from the YYMMDD TIME folder.

```
O:\EZStart\Projects\Great Plains Methane\AI\2012\SITE\YYMMDD TIME.
```

XII. **Processing and Reprocessing Data**
a. This is an important option that will let you review individual graphs in a sequence. Note: the run must not be in progress for this to work. This option is convenient for checking the consistency of standards, the presence of false peaks, abnormal integration or curves, or reviewing data.
b. Open the desired sequence (in EZStart or EZStart Offline). (File > Sequence > Open)
   Sequence > Process…
c. In the popup window: Check ‘Review’ to look at individual graphs. Select ‘Process’. The screen will return to the normal EZStart view. There are green up and down arrows at the bottom of the program. These will scroll through the graphs. To end, click the red stop icon at the top toolbar.
d. It is now important to reprocess the data. (Sequence > Process…) In the popup window, uncheck the review option and click ‘Process’.

XIII. **Removing a Standard Calibrant from Calibration/Recalibration**
a. If the standard calibrants are off, it is often possible to tell which, if any, standard is correct by comparing to previous runs, later runs, or repeat standards. When the incorrect standard calibrant is identified, it is necessary to take the sample out of the calibration. Open the sequence file with the incorrect standard calibrant.
b. Find the calibrant standard and change its level to 0 (zero). The current level will be a 1-7. Save the sequence and reprocess (with Review unchecked, see Processing and Reprocessing Data).
XIV. Troubleshooting Machines
a. Auto Sampler not working...
i. If GC was previously shut off (from hard shutdown): turn GC back on (white power on switch) and press start button to apply the method, retry starting run.
b. No process summary...
i. The first sample needs to include ‘Summary Begin’. To check this, click to open the option. Check ‘Summary Begin’.
ii. In the right side of the popup window, make sure that the summary follows the file path:
O:\EZStart\Projects\Templates\Summary 22
iii. Click ‘OK’ and save sequence.

XV. Shutting Down
a. Turn off LGR; exit, ‘okay’, wait until screen says power down, turn on switch in back
b. Turn off zero gas switch (flip valve down)

XVI. Extracting Data
a. The YYMMDD TIME files need to be transferred to the MM folder in Joe Drive.
   Z:\Great Plains Methane\AI\2012 \SITE\YYMMDD TIME
b. Once they are transferred, the summary reports can be opened in Excel from other computers accessing the Joe Drive. Be sure to open the excel files and enter any information recorded in the notebook that Evan should take note of. Make sure to enter the time that each set of samples was taken on the file as well.
c. Remember it is important to delete and retransfer files to the Joe Drive if changes are made to sequences (i.e. recalibration).

Glossary
GC – (Gas Chromatograph) Gas sampling machine includes the Autosampler and computer
Joe Drive – Network Drive located under “my computer” > vonFischerData$
LG GHGA – Los Gatos Green House Gas Analyzer: Laser gas analyzer that can give a reading for methane levels in a sample that the GC takes. It is connected to the GC by a tube that the zero air flows through. The zero air (N2) acts as a carrier gas as the sample is injected into the tube it flows to the GHGA

Figure 18: LG
Shake Table – This table is located in the northwest corner of the lab. The trays that hold the vials fit into it and can be removed to be placed on the GC for sampling.

Soil Plot/Site – One group of six soil cores from a site located in the Great Plains
Soil Core – One of six soil samples taken from the same plot.

Appendix A: Ammonium Inhibition Labeling Reference Guide

<table>
<thead>
<tr>
<th>Vials in GC Runs</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vial Label</td>
<td>[CH4] (ppm)</td>
<td>Vol. gas inject</td>
<td>[NH4Cl] (mM)</td>
</tr>
<tr>
<td>Air 1</td>
<td>Lab air (1.8)</td>
<td>25 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 3-1</td>
<td>5.03</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>no soil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>soil</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>no</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>soil</td>
</tr>
<tr>
<td>Std 3-2</td>
<td>5.03</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>Std 4-1</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-2</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 5-1</td>
<td>30</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 5-2</td>
<td>30</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>A1-1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>A1-0.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A1-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A1-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A1-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A1-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>A2-1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>A2-0.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A2-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A2-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A2-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A2-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>A3-1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>A3-0.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A3-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A3-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A3-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A3-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>CTRL-1</td>
<td>20</td>
<td>30 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-3</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-4</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>A4-1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>A4-0.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A4-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A4-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A4-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A4-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>A5-1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>---</td>
<td>-----------</td>
<td>----</td>
</tr>
<tr>
<td>A5-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A5-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A5-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A5-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A5-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>A6-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>A6-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>A6-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>A6-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>A6-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>A6-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>DI-A-1</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-A-2</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-A-3</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-A-4</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-A-5</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-A-6</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>CTRL-2</td>
<td>20</td>
<td>30 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-5</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-6</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Air 2</td>
<td>25 ml</td>
<td></td>
<td>none</td>
</tr>
<tr>
<td>Std 3-3</td>
<td>5.03</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 3-4</td>
<td>5.03</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-7</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-8</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 5-3</td>
<td>30</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 5-4</td>
<td>30</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>B1-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B1-3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B1-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B1-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B1-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>B1-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>B2-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B2-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B2-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B2-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B2-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>B2-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>B3-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B3-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B3-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B3-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B3-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>B3-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>CTRL-3</td>
<td>20</td>
<td>30 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-9</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>Std 4-10</td>
<td>15</td>
<td>90 ml</td>
<td>none</td>
</tr>
<tr>
<td>B4-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B4-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B4-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B4-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B4-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>B4-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>B5-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B5-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B5-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B5-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B5-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>B5-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>B6-.1</td>
<td>20</td>
<td>25 ml</td>
<td>0.1</td>
</tr>
<tr>
<td>B6-.3</td>
<td>20</td>
<td>25 ml</td>
<td>0.3</td>
</tr>
<tr>
<td>B6-1</td>
<td>20</td>
<td>25 ml</td>
<td>1</td>
</tr>
<tr>
<td>B6-3</td>
<td>20</td>
<td>25 ml</td>
<td>3</td>
</tr>
<tr>
<td>B6-10</td>
<td>20</td>
<td>25 ml</td>
<td>10</td>
</tr>
<tr>
<td>B6-100</td>
<td>20</td>
<td>25 ml</td>
<td>100</td>
</tr>
<tr>
<td>DI-B-1</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-B-2</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-B-3</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
<tr>
<td>DI-B-4</td>
<td>20</td>
<td>25 ml</td>
<td>0</td>
</tr>
</tbody>
</table>
### Appendix B: NH4Cl Dilutions and 20ppm Methane Dilution

<table>
<thead>
<tr>
<th>NH4 Bottle</th>
<th>DI H2O (Ls)</th>
<th>NH4Cl</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1 mM NH4</td>
<td>1.8</td>
<td>200mL from 1mM</td>
</tr>
<tr>
<td>0.3 mM NH4</td>
<td>1.8</td>
<td>200mL from 3mM</td>
</tr>
<tr>
<td>1 mM NH4</td>
<td>1.8</td>
<td>200mL from</td>
</tr>
</tbody>
</table>
### Gas Bag Dilution: use to make gas bag for 20ppm CH4

<table>
<thead>
<tr>
<th>C(gas tank) *</th>
<th>V(gas from tank)</th>
<th>C(free air) *</th>
<th>V(free air)</th>
<th>C(gas bag)</th>
<th>V(tank) + V(free air)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ppm</td>
<td>mL</td>
<td>ppm</td>
<td>mL</td>
<td>ppm</td>
<td>mL</td>
</tr>
<tr>
<td>100.01</td>
<td>2200</td>
<td>1.8</td>
<td>1500</td>
<td>60.195135</td>
<td>3700</td>
</tr>
</tbody>
</table>

### CH4 Dilutions in 60mL Vials

<table>
<thead>
<tr>
<th>C(gas bag) *</th>
<th>V(injected from bag)</th>
<th>C(free air) *</th>
<th>V(headspace)</th>
<th>C(vial)</th>
<th>V(injected)+V(headspace)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ppm</td>
<td>mL</td>
<td>ppm</td>
<td>mL</td>
<td>ppm</td>
<td>mL</td>
</tr>
<tr>
<td>60.19513514</td>
<td>25</td>
<td>1.8</td>
<td>56</td>
<td>19.823</td>
<td>81</td>
</tr>
</tbody>
</table>

### Percent Change from Desired CH4 Level to Actual CH4 Level in Vials

<table>
<thead>
<tr>
<th>Desired CH4</th>
<th>Actual CH4</th>
<th>Percent Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>ppm</td>
<td>ppm</td>
<td>%</td>
</tr>
<tr>
<td>20</td>
<td>19.8232</td>
<td>0.884</td>
</tr>
</tbody>
</table>

### Calculations

<table>
<thead>
<tr>
<th>c(t)</th>
<th>c(f)</th>
<th>c(gb)</th>
<th>V(i)</th>
<th>c(v)</th>
<th>V(tot)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100.01</td>
<td>2200</td>
<td>1.8</td>
<td>1500</td>
<td>60.195135</td>
<td>3700</td>
</tr>
<tr>
<td>60.19513514</td>
<td>25</td>
<td>1.8</td>
<td>56</td>
<td>19.82319</td>
<td>81</td>
</tr>
</tbody>
</table>
Appendix C: Ammonium Inhibition Tray Setup for Runs

<table>
<thead>
<tr>
<th>TRAY 1</th>
<th>TRAY 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air 1</td>
<td>A2-100</td>
</tr>
<tr>
<td>Std 3-1</td>
<td>A3-.1</td>
</tr>
<tr>
<td>Std 3-2</td>
<td>A3-.3</td>
</tr>
<tr>
<td>Std 4-1</td>
<td>A2-1</td>
</tr>
<tr>
<td>Std 4-2</td>
<td>A3-1</td>
</tr>
<tr>
<td>Std 5-1</td>
<td>A3-10</td>
</tr>
<tr>
<td>Std 5-2</td>
<td>A3-10</td>
</tr>
</tbody>
</table>

percent off
0.884050717
### TRAY 3

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A3-100</td>
<td>Std 4-4</td>
<td>A4-1</td>
<td>A4-100</td>
<td>A5-1</td>
</tr>
<tr>
<td>CTRL-1</td>
<td>A4-.1</td>
<td>A4-3</td>
<td>A5-.1</td>
<td>A5-3</td>
</tr>
<tr>
<td>Std 4-3</td>
<td>A4-.3</td>
<td>A4-10</td>
<td>A5-.3</td>
<td>A5-10</td>
</tr>
</tbody>
</table>

### TRAY 4

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A6-1</td>
<td>A6-100</td>
</tr>
<tr>
<td>A6-3</td>
<td>DI-A1</td>
</tr>
<tr>
<td>A6-10</td>
<td>DI-A2</td>
</tr>
</tbody>
</table>

### TRAY 5

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DI-A3</td>
<td>DI-A6</td>
<td>Std 4-6</td>
<td>Std 3-4</td>
<td>Std 5-3</td>
</tr>
<tr>
<td>DI-A4</td>
<td>CTRL-2</td>
<td>Air 2</td>
<td>Std 4-7</td>
<td>Std 5-4</td>
</tr>
<tr>
<td>DI-A5</td>
<td>Std 4-5</td>
<td>Std 3-3</td>
<td>Std 4-8</td>
<td>B1-.1</td>
</tr>
</tbody>
</table>

### TRAY 6

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B1-10</td>
<td>B2-.3</td>
</tr>
<tr>
<td>B1-100</td>
<td>B2-1</td>
</tr>
<tr>
<td>B2-.1</td>
<td>B2-3</td>
</tr>
</tbody>
</table>

### TRAY 7

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B2-10</td>
<td>B3-.3</td>
<td>B3-10</td>
<td>Std 4-9</td>
<td>B4-.3</td>
</tr>
<tr>
<td>B2-100</td>
<td>B3-1</td>
<td>B3-100</td>
<td>Std 4-10</td>
<td>B4-1</td>
</tr>
<tr>
<td>B3-.1</td>
<td>B3-3</td>
<td>CTRL-3</td>
<td>B4-.1</td>
<td>B4-3</td>
</tr>
</tbody>
</table>

### TRAY 8

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B5-.3</td>
<td>B5-10</td>
</tr>
<tr>
<td>B5-1</td>
<td>B5-100</td>
</tr>
<tr>
<td>B5-3</td>
<td>B6-.1</td>
</tr>
</tbody>
</table>

### TRAY 9 - THESE WILL BE IN BLANK SPACES DURING SHAKING AND MOVED INTO TRAY 1 TO SAMPLE

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B6-.3</td>
<td>B6-10</td>
<td>DI-B2</td>
<td>DI-B5</td>
<td>Std 4-11</td>
</tr>
<tr>
<td>B6-1</td>
<td>B6-100</td>
<td>DI-B3</td>
<td>DI-B6</td>
<td>Std 4-12</td>
</tr>
<tr>
<td>B6-3</td>
<td>DI-B1</td>
<td>DI-B4</td>
<td>CTRL-4</td>
<td></td>
</tr>
</tbody>
</table>